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 Getting Started

  About Screen Receiver k
  Screen Receiver provides the following functions.• 

  Display of calculator screen images on a computer connected via a USB cable -

  Real-time display of calculation operation results -

  Zooming of display contents -

  Capture of screen contents -

  Copy and paste of captured screen images to other applications -

  Storage of captured screen images as image files -

 Printing of captured screen images -

Using This Manual k
In this manual, different calculator models are referred to as shown below.• 

Type A Calculator: fx-CG10 Series, fx-CG20 Series, fx-CG50 Series, GRAPH90+ E

Type B Calculator: ClassPad 330 PLUS

Type C Calculator: ClassPad II, fx-CG500

The procedures in this manual assume that you are already familiar with the following standard • 
computer operations.

 Menu operations using the mouse, including: clicking, double-clicking, dragging, etc.• 

  Text input using the keyboard -

  Icon operations, general window operations, etc. -

  If you are not familiar with these types of operations, refer to the user documentation for your  -
computer.

  The explanations in this manual cover both Windows and Mac OS. Most of the screen shots are • 
from Windows 8.1, but operational procedures are virtually identical for both Windows and Mac 
OS.

  Note that the actual appearance of the screen that appears when using this software depends • 
on your computer system setup and on the operating system you are using.

  Screen shots shown in this User’s Guide are intended for illustrative purposes only. The actual • 
text and values that appear on display may differ from the examples shown in this User’s Guide.

This manual explains Screen Receiver operations using a • Type A Calculator. Screen Receiver 
operations are identical when using a Type B or Type C Calculator. 
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System Requirements k

Windows

Operating Systems:
Windows 7 (32-bit/64-bit), Windows 8.1 (32-bit/64-bit), Windows 10 (32-bit/64-bit)
Your hardware configuration needs higher than functionalities that operating system 
recommends.

Computer: Computer with one of the Windows operating systems pre-installed (Excluding 
computers with an upgraded operating system and self-built computers.)

Disk Space: 100MB for installation and uninstall

Note: Actual requirements and product functionality may vary based on your system 
configuration and operating system. 

Other: USB port for direct connection. Do not connect via a USB hub.
Video adapter and display must support resolution of XGA (1024×768) or higher, 16 
bit or higher system color. 
Internet Explorer® 7 or later.
Adobe® Reader® 8.0 or later. 

Mac OS

Operating Systems:
OS X 10.10, OS X 10.11, macOS 10.12, macOS 10.13
Your hardware configuration needs higher than functionalities that operating system 
recommends.

Computer: Intel® Processer
Computer with one of the Macintosh operating systems pre-installed (Excluding 
computers with an upgraded operating system.)

Disk Space: 100MB for installation and uninstall

Note: Actual requirements and product functionality may vary based on your system 
configuration and operating system.

Other: USB port for direct connection. Do not connect via a USB hub.
Video adapter and display must support resolution of XGA (1024×768) or higher.
For Retina display, use of the Low Resolution mode is recommended.
Safari 3.0 or later.

Note
For the latest information about system requirements, visit the website at the URL below:• 
http://world.casio.com/support/os_support/

Windows, Windows Vista• ® and Internet Explorer are registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries.

Mac, Mac OS, OS X, macOS, Macintosh, Safari and Retina are registered trademarks or • 
trademarks of Apple Inc. in the United States and/or other countries.

Intel is a registered trademark or trademark of Intel Corporation in the United States and/or • 
other countries.

Adobe and Reader are either registered trademarks or trademarks of Adobe Systems • 
Incorporated in the United States and/or other countries.

Company and product names used herein are trademarks of their respective owners. • 

Note that trademark ™ and registered trademark • ® are not used within the text of this user’s 
guide.

http://world.casio.com/support/os_support
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 1. Installing and Uninstalling Screen Receiver
  This section explains how to install and uninstall Screen Receiver.

  To install Screen Receiver

  Note
  Do not install Screen Receiver into a folder that is used by other software.• 

   1.  On your computer, double-click the Screen Receiver application EXE file. 

2. Perform operations as instructed by the text that appears on the screen.

3. The dialog box shown below will appear when installation is complete.

 

   4.  Click the [Finish] button.

  This completes installation.• 

  Note
  Installing the software will put a “Screen Receiver” shortcut icon on your desktop.• 
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 To uninstall Screen Receiver

Windows

1. Display the Windows Control Panel.

2. Click [Programs and Features].

3. On the list of applications that appears, select “Screen Receiver”.

4. Click the [Uninstall] button.

This will display the program maintenance wizard.• 

5. Click the [Yes] button.

This completes the uninstall operation.• 

Mac OS

1. Move Screen Receiver(.app) to the Trash folder.

2. From the menu, select [Finder] and then [Empty Trash].

To start up Screen Receiver

1. Windows: On your computer’s desktop, double-click the “Screen Receiver” icon. 
Mac OS: In the “Applications” - “CASIO” folder, double-click “Screen Receiver”.

Windows: You could also start up the application by clicking [Start] - [Program] - [CASIO] - • 
[Screen Receiver] - [Screen Receiver]. 

Windows Mac OS
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 2. Screen Configuration
 The following shows the Screen Receiver screen.

When connected to a  k Type A Calculator

Menu Bar

Toolbar

Calculator screen

Status Bar

Windows

Captured data windows
Data area

Menu Bar

Toolbar

Calculator screen

Status Bar

Mac OS

Captured data windows
Data area
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When connected to  k a Type B Calculator

Windows

Mac OS
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When connected to  k a Type C Calculator

Windows

Mac OS
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 Menu Bar
  This section explains the Screen Receiver menu bar.• 

  If a menu command can also be executed by clicking a toolbar button, the applicable toolbar • 
button is also provided.

 File Menu k

Menu
Toolbar 
Button

Description

Close Closes the active captured data window.

Capture Screen
Captures the calculator screen. Each capture adds a capture 
screen to the captured data area.

Save
Saves the contents of the active data capture window, 
overwriting the existing data.

Save As
Saves the contents of the active data capture window under 
a new file name.

Print Prints the contents of the active captured data window.

Print Preview*1 Displays a preview of the print image. 

Print Setup Displays the print setup dialog box. 

Exit*2 Exits Screen Receiver.

*1 Windows only
*2 Mac OS: On the [Screen Receiver] menu, selected [Quit Screen Receiver].
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 Edit Menu k

  

  Menu  
  Toolbar 
Button  

  Description  

 Copy   
 Copies the contents of the active captured data window to 
the clipboard. 

  Screen Receive Menu k

  

  Menu  
  Toolbar 
Button  

  Description  

 Start   
 Establishes a connection between Screen Receiver and 
calculator and displays the calculator screen contents. 

 Stop   
 Terminates the connection between Screen Receiver and the 
calculator. 
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  View Menu k

  

  Menu    Submenu  
  Toolbar 
Button  

  Description  

 Reduce   
 Reduces the size of contents of the active captured 
data window. 

 Expand   
 Expands the size of the contents of the active 
captured data window. 

 Zoom  × 1 
 Displays the contents of the active captured data 
window in its actual size. 

 × 2 
 Displays the contents of the active captured data 
window as 2X its actual size. 

 × 3 
 Displays the contents of the active captured data 
window as 3X its actual size. 

 Toolbar  Toggles display of the toolbar on and off. 

 Status Bar  Toggles display of the status bar on and off. 
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Window Menu k

Menu Description

Cascade Stacks captured data windows.

Tile Horizontal*1 Lines up captured data windows horizontally.

Tile Vertical*1 Lines up captured data windows vertically.

Arrange Icons Displays captured data windows as icons.

Close All Closes the all captured data windows.

(Captured data) Shows the names of the displayed captured data.

*1 Windows only

Tools Menu (Windows only) k

  Menu    Description  

 Options*1  Displays a dialog box for configuring optional settings.  

*1 Mac OS: On the [Screen Receiver] menu, selected [Preferences...].

 Captured data 
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Help Menu k

Menu Description

Manual Displays the Screen Receiver User’s Guide. 

License Displays the end user license agreement. 

About*1 Displays version information. 

*1 Mac OS: On the [Screen Receiver] menu, selected [About Screen Receiver].

Status Bar

1 2 3

1 Help text is displayed here (Windows only).

2 Folder where captured data is stored

3 File name extension of captured data files
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  3. Using Screen Receiver

  3-1  Establishing a Connection between Screen Receiver 
and a Calcualtor

  Important!
  Do not connect the calculator to the computer before starting up Screen Receiver. Start up • 
Screen Receiver first.

   1.  Start up Screen Receiver.

   2.  Use the USB cable that comes with the calculator to connect it to your computer. 

 This will display the dialog box shown below.• 

Type A Calculator Type B or Type C Calculator

3. Type A Calculator:
For Windows Vista, Windows 7, Windows 8, Windows 8.1 user: press 2. 
For Windows XP user: press 3. 
For Mac OS user: press 2.

 Type B or Type C Calculator:
For Windows Vista, Windows 7, Windows 8, Windows 8.1 user: tap [Screen Receiver], or 
press the 2 key.
For Windows XP user: tap [Screen Receiver(XP)], or press the 3 key.
For Mac OS user: tap [Screen Receiver], or press the 2 key.

This will display the dialog box shown below.• 

Type A Calculator Type B or Type C Calculator
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USB Connection Precautions • 

A USB connection between the calculator and a computer may be terminated automatically 
if the computer enters a power save mode, sleep mode, or any other standby state. If this 
happens, disconnect and then reconnect the USB cable.

   4.  Type A Calculator: Press  J.
 Type B or Type C Calculator: Tap [OK].

This automatically establishes a connection between Screen Receiver and the calculator, • 
and displays the calculator screen on the Screen Receiver window. Wait until the calculator 
screen appears on the Screen Receiver window before performing any calculator operation. 

Windows Mac OS

Calculator screen Calculator screen

5. Perform the operations you want on the calculator.

The calculator screen displayed by Screen Receiver will change in real time as you perform • 
operations on the calculator.

  6.  To terminate the connection between Screen Receiver and calculator, click .

   7.  Disconnect the USB cable from the computer and calculator.

  Note
  If the connection between Screen Receiver and the calculator terminates for some reason, click • 

 to reconnect.

  3-2  Calculation Operation Precaution
 The way figures are drawn and the cursor moves on the Screen Receiver screen may not • 
exactly match what appears on the calculator screen. 

Attention Windows Vista, Windows 7, Windows 8 and Windows 8.1 users • 
The calculator does not support the operations below while there is a connection between the 
calculator and Screen Receiver.

 File delete -
  Folder create or rename -
  Backup -
  Optimization -
  Reset operations (Add-In, Storage Memory, Add-In&Storage, Main&Storage, Initialize All,  -
Language File)

  Screen Receiver will not display the calculator screen while the calculator is performing a file 
save operation. The calculator screen will appear after the file save is complete.
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  3-3  Capturing the Calculator Screen

   1.  Perform the required operation on the calculator to display the screen you want to capture.

   2.  Click .

  This displays the captured data.• 

  

   3.  Repeat steps 1 and 2 to capture other screens, if you want.

  Note
  You can put a frame around the captured data by clicking • . Each click toggles between 

framed and unframed data. For more information, see “4-2 Capture Settings” (page E-24).
  

 Captured data 
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  3-4  Making a Captured Data Window Active
  Clicking a captured data window makes it the active window.

  

  Note
  Only one captured data window can be active at any time.• 

  To zoom, copy, save, or print the contents of a captured data window, you first must make it the • 
active window.

  3-5  Copying Captured Data Window Contents to the 
Clipboard

   1.  Make the captured data window that contains the data you want to copy the active window.

   2.  Click  to copy the captured data to the clipboard.

  3-6  Saving Captured Data
  Make the window that contains the captured data you want to save the active window, and then 

click .

  Note
  Saved captured data is automatically assigned a file name of the following format: DispCapXX. • 
XXX.

  The file format (bmp, jpg, png) and storage folder are in accordance with the settings described • 
under “4-1 File Save Settings” (page E-24).

  You can use the [Save As] command on the [File] menu to save the file under a different name.• 
  

 Active captured data 
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  3-7  Auto File Save
  Attempting to exit Screen Receiver while there is unsaved captured data will cause the dialog box 
shown below to appear.

  

1

2

1 Specifies the file format for the saved file. You can select bmp, jpg, or png.

2 If there is already a file with the same name that you specify, this option specifies whether or 
not the older version should be overwritten with the new one.

  3-8  Resizing a Screen Image

  To resize the calculator screen 

  Right-click the calculator screen. Click [Zoom] on the shortcut menu that appears and then select 
a zoom factor.
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  To resize the calculator screen when capturing it 

  On the toolbar, click the down arrow button of the zoom box. On the menu that appears, select a 
zoom factor.

  

  To resize captured data 

  Make the window that contains the captured data you want to resize the active window, and then 

click  or . You can select one of three sizes.

  

 
   → 
   ← 

   
  

 
   → 
   ← 

   
  

  You also can resize by selecting a zoom factor with the [Zoom] command on the [View] menu.
  

 Zoom menu 
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  3-9  Using a Floating Calculator Screen (Windows only)
  You can display the calculator screen in its own window that is separate from the Screen 
Receiver window.

  To make the calculator screen a floating screen

   1.  Double-click the calculator screen.

   2.  Drag the calculator screen to the location you want, either inside or outside of the Screen 
Receiver window.

  

  To return a floating calculator screen to the Screen Receiver window
  Double-click the floating calculator screen. -

  Drag the calculator screen back to the left side of the Screen Receiver window. -

  Important!
  You can return a floating calculator screen only to the left side of the Screen Receiver window. • 
Dragging top, bottom, or right side of the main window will not work.
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  3-10  Printing
  You can print the contents of a captured data window, if you want.• 

   1.  Make the captured data window that contains the data you want to print the active window.

   2.  Click . This will display the Print dialog box.

  

   3.  Click [OK] to start printing.

  Important!
  Only the contents of the currently active captured data window can be printed. You cannot print • 
the contents of multiple captured data windows with a single print operation.

  Images are printed in accordance with width setting of the paper size selected on the Print • 
dialog box.
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  Print Preview (Windows only) k
  Click •  to display the print preview window.

  

1 2 3 4

1 Displays the Print dialog box.

2 Enlarges the preview image.

3 Reduces the size of the preview image.

4 Closes the print preview window image.

  Print Setup Dialog Box k
  Selecting [Print Setup] on the [File] menu displays the Print Setup dialog box.• 
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 3-11  Shortcut Menu
On the calculator screen or captured data window, right-clicking with your mouse (Windows) or 
performing a control+click (Mac OS) will cause the shortcut menu shown below to appear.

 
  Calculator screen 

 
  Captured data 
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 4. Tool Options Dialog Box

  4-1  File Save Settings 

  

1

2

1 File name extension of captured data files

2 Storage folder

  4-2  Capture Settings

  

1

2

1 Specifies unframed captured screen images

2 Specifies framed captured screen images, and frame thickness.

   Captured data example

 
  Unframed 

 
  Framed 
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 5. Error Message Table

  Message    Description    Required Action  

 A problem occurred while 
writing file <file name>.
  The disk being written to may 
be damaged or may not exist. 
Check the disk and try again. 

 A problem occurred while 
writing to a disk.  

 Check the disk for data 
corruption and confirm that 
the disk exists. Then try 
again.  

 A problem occurred while 
launching the manual (***.pdf) 
viewer.
  Download the viewer from the 
site below and reinstall it.
  http://get.adobe.com/reader/
  otherversions/ 

 A problem occurred during 
manual viewer startup.  

 Download and install a new 
viewer from 
 http://get.adobe.com/reader/
    otherversions/ .  

 The path and/or filename 
exceeds the maximum length 
allowed by your Windows* 
operating system. 

 The number of letters in 
the path or file name you 
specified exceeds the 
allowable limit.  

 Shorten the specified path or 
file name.  

 A connection could not be 
established.
  Either the calculator is not 
connected or the connected 
calculator is not in the Screen 
Receiver Mode.
  Correct the problem and try 
again.
  For details, select the 
following on the menu bar: 
Help - Manual, or refer to the 
Screen Receiver user’s guide.  

 You started a data 
communication operation 
while the USB cable was not 
connected.  

 Check for proper connection 
of the calculator to the 
computer. Then try again. 
  See “3. Using Screen 
Receiver” for details.  

 A problem occurred during 
communication.
  Disconnect the USB cable, 
check the setup of the 
calculator, and try again.
  For details, select the 
following on the menu bar: 
Help - Manual, or refer to the 
Screen Receiver user’s guide.  

 Some problem occurred 
during data communication.  

 Disconnect the USB cable 
and check the setup of the 
calculation. Then try again.
  See “3. Using Screen 
Receiver” for details. 

http://get.adobe.com/reader/otherversions/
http://get.adobe.com/reader/otherversions/


E-26

  Message    Description    Required Action  

 The image could not be sent 
from the calculator.
  (1)  Try pressing a key on the 

calculator.
  (2)  Check to make sure that 

the calculator is in the 
Screen Receiver Mode.

  If the screen is not sent after 
you perform the above steps, 
disconnect the USB cable 
and check the calculator 
setup. Next, reconnect and 
try again.
  For details, select the 
following on the menu bar: 
Help - Manual, or refer to the 
Screen Receiver user’s guide.  

 The calculator screen image 
cannot be sent for some 
reason.  

 Follow the steps that are 
shown on the display and try 
again. 
  See “3. Using Screen 
Receiver” for details.  

 The connection has been 
broken for some reason and 
is being restored. 
  If data communication does 
not resume after some 
time, perform the operation 
described below.
  Try pressing a key on the 
calculator. If the screen is 
not sent after you perform 
the above steps, disconnect 
the USB cable and check 
the calculator setup. Next, 
reconnect and try again. 
  For details, select the 
following on the menu bar: 
 Help - Manual, or refer to the 
Screen Receiver user’s guide. 

 — 

 Follow the steps that are 
shown on the display and try 
again. 

 The application is already 
running.
  Another user may already be 
using the application. 

 Another user is running 
Screen Receiver. 

 Wait until the other user shuts 
down Screen Receiver. 

* Mac OS: Macintosh
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